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WXP1015 

Introduction to Max/MSP Programming 

 

 

Level 4:  Full year:  20 credits. 

 

Pre-requisites:  GCSE Maths Grade C or equivalent. 

 

Co-requisites:  WXK1012 (Practical Music Technology). 

 

Description: Cycling 74’s Max/MSP is the key tool used by most interactive digital artists 

specializing in audio and/or video. This module introduces students to the Max/MSP 

programming environment, and enables them to begin building a wide variety of music, 

audio and video creativity applications. The module introduces Max/MSP from first 

principles, and takes a step-by-step approach aiming to achieve something practical and 

useful at every stage. 

Method, frequency and number of classes:  In each semester there will be 9 studio-based 

classes of 1 hour, plus one Reading Week. In the final two weeks of each semester there 

will be optional tutorial-based problem-solving clinics. 

Assessment:  Submission of eight technical exercises (four in each semester), assessing 

Learning Outcomes 1-5 (60% of the available marks in total, with each exercise equally 

weighted), together with two main programming assignments, one submitted in Week 13 of 

each semester, assessing Learning Outcomes 1-5 (40% of the available marks). 

Learning Outcomes: 

On completion of the module, the student will be able to: 

1. build simple working Max/MSP applications demonstrating a variety of basic 

principles and techniques; 

2. understand basic principles of audio signal processing and control; 

3. formulate simple, practical solutions to problems in creative multimedia practice; 

4. create basic programming solutions that facilitate use of the creative imagination; 

5. work confidently within the Max/MSP environment. 

 

Co-ordinator:  Dr Edward Wright and Professor Andrew Lewis. 

Front cover image from Ircam CataRT - http://imtr.ircam.fr/imtr/CataRT_App_Documentation



 
Introduction to Max/MSP WXK1015.             Contact - ed.wright@bangor.ac.uk                        Page ii  

 



 
Introduction to Max/MSP WXK1015.             Contact - ed.wright@bangor.ac.uk                        Page iii  

 

Introduction to Max/MSP 

WXK1015 

Semester 1 

 

Weekly plan: 

 

 Week 1 – Introduction to Max/MSP programming. 

 Week 2 – Working with audio. 

 Week 3 – Numbers, messages and lists. - - Course work 1 due. 

 Week 4 – Programme flow and control. 

 Week 5 – Making patches simpler. - - - Course work 2 due. 

 Week 6 – Playing audio samples. 

 Week 7 – Reading week (no lecture). 

 Week 8 – Simple MIDI control.  - - - Course work 3 due. 

 Week 9 – Enveloping and cross-fading. 

 Week 10 – Designing the user interface.  - - Course work 4 due. 

 Week 11 – Optional programming clinic 1 

 Week 12 – Optional programming clinic 2 

 Week 13 – No lecture.  - - - -    Main assignment 1 due.  

 

Assessment pattern: 

 

Work Set week Submission week % of module 

    

Course work 1 1 3 5 

Course work 2 3 5 5 

Course work 3 5 8 5 

Course work 4 8 10 5 

Main assignment 1 1 13 40 

 

 

N.B. A total of 50% of the available marks are in this semester and 50% in 

semester 2. 
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Suggested Reading. 

 

Boulanger, Richard Charles, and Victor Lazzarini. The Audio Programming Book. Cambridge, MA: 

MIT, 2011.  

 

Cipriani, Alessandro, and Maurizio Giri. Electronic Music and Sound Design: Theory and Practice 

with Max/MSP. Rome: Contemponet, 2010.  

 

Roads, Curtis. The Computer Music Tutorial. Cambridge, MA: MIT, 1996.  

 

"Cycling '74: Innovative Software." YouTube. YouTube, n.d. Web. 23 Aug. 2012. 

<http://www.youtube.com/user/cycling74com>. 

 

"Max 5 Help and Documentation." Max 5 Help and Documentation. N.p., n.d. Web. 23 Aug. 2012. 

<http://cycling74.com/docs/max5/vignettes/intro/docintro.html>. 

 

"Object Thesaurus." Object Thesaurus. N.p., n.d. Web. 23 Aug. 2012. 

<http://cycling74.com/docs/max5/vignettes/thesaurus/thesaurus.html>. 
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WXK-1015 Introduction to Max/MSP 

Main Assignment 1 

40% of total module marks. 

 

In Max/MSP create a software instrument, capable of playing back and manipulating pre-recorded 

samples as well as the facility for additive synthesis. 

In addition to this the patch must have a well developed user interface, make use of presentation 

view and be clearly commented when unlocked. 

Credit will also be given to work that fulfils this remit and then further extends this scope (for 

example but not limited to: to include gestural control with a foot-pedal or manipulation of 

synthesis parameters via webcam). 

Marks will be awarded based on the module learning outcomes. 

 

 

Due: Week  13 12 noon 

Submission method - you must BOTH: 

(a) Submit the work on CD in a clear plastic CD wallet NOT jewel case  

with covering form to the MUSIC OFFICE. 

(b) compress your patch (as a .zip file) and submit it via Blackboard 

 

Marks will be reduced for late or incorrectly formatted work. 
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Introduction to Max/MSP 

WXK1015 

Semester 1 

 

Week 1 – Introduction to Max/MSP programming 
 

What is Max/MSP? 

 

Max/MSP (often just called ‘Max’) is a ‘multimedia programming environment’ which will allow 

you to create pretty much any kind of music or audio software you can think of. It can also handle 

video using a built-in extension called ‘Jitter’. 

To get more of an idea of what Max can do, visit the website www.cycling74.com and click on the 

‘projects made with Max’ link. 

 

Making your first ‘Patch’ 

 

A programme in Max is a called a ‘Patch’ (or ‘Patcher’). This is because it is made by connecting 

(or ‘patching’) graphical objects together on the screen. To create a new patch, select File>New 

Patcher  ( ⌘n). This creates the window in which you will make your patch. The patcher has two 

modes, EDIT MODE for editing the patch (creating objects, making connections), and LOCKED 

MODE for actually using the patch. If you want to press buttons, move sliders and so on, you need 

to lock the patch by ⌘e Now double-click anywhere in the window. The object pallet appears. If 

you hover over each object, you will see its name. (There are many more objects than these – but 

these are the most common, basic ones.) When you’ve made an object, you can resize it, drag it 

around the screen, cut, copy and paste it. If you drag it while holding alt, you also get a copy. As 

well as the objects shown in the palette, there are many more objects. To create these you must use 

an object box, which is a ‘blank’ box into which you type an object name. Objects are really small 

programs which you put together to make larger programs. 

 

Elements 

 

There are several different elements that go to make up a patch. The 

message box is simply a container for any piece of text or a number which 

gets sent when clicked on.  

 

A max object carries out some sort of function on data going through it. 

 

 

An msp object works similarly to a max object but at a far higher processing 

speed and is therefore more suited to direct handling of audio data. It looks 

different and has a ~ sign in the name to remind you that it is msp and not max. 

 

Arguments can be added to an object to tell it how to behave, for instance a cycle~ object will 

generate a sine wave but the addition of the argument 440 will make the sine wave oscillate at 440 

Hz. 
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A comment box lets you comment on your patch. This is useful in that it 

can tell you or other people working on it how the patch is put together, 

which is very helpful for fault finding, and  revision. 

 

 

Objects can be connected together with patch cords. Each 

object has inlets at the top, and outlets at the bottom. You 

make a patch cord by dragging from the outlet of an object. 

When you stretch the cord to nearby the inlet of another object, 

a comment appears telling you about that inlet. When you let 

go (of the mouse) the connection is made. You can only 

connect outlets to inlets (i.e. bottom to top). Different objects 

have different functions. They also have different numbers of 

inlets and outlets depending on their function. 

 

Order of Execution 

 

By default Max will work from right to left and top to bottom across the patcher, in many cases this 

can only mean fractions of milliseconds difference, but in some cases this can be crucial. 

 

HELP! 

 

All objects have a built in help file. To see this alt-click on the object. The help files are not just 

manual pages, but working patches in themselves. You can unlock them, see what’s going on, copy 

the contents and paste it into your own patch. THIS IS VERY USEFUL! 

Each help file also has an open object reference link at the top right, which takes you to a more 

comprehensive manual page for that object. It also has a See Also link at the bottom right, which 

shows objects that do similar things to the one you’re looking at. 

 

Keeping things neat 

 

It is important to try to keep your patch neat. Things can get very messy and tangled if you’re not 

careful, and then finding and fixing problems can be a real nightmare. To align objects and patch 

cords nicely, select them and type ⌘y Commenting your patch is also very important. 

 

SAVE! 

 

Always save your work! Always do this often! And always give your patch a name which contains 

your initials. Work should be saved in a folder labelled: 

 

[yourname]max2012 in documents. 

 

You should also keep backups of everything. Computers DO FAIL so important work should be 

saved in a minimum of 3 places which are not directly physically connected eg. 1. studio computer, 

2. on CD-R 3. online. Loss of data will not be regarded as an excuse… 
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Above, this week’s patch unlocked with examples at bottom. 

Below the same patch locked and formatted in presentation view. 
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WXK-1015 Introduction to Max/MSP 

Coursework 1 

5% of total module marks. 

 

Starting from the patch that we created at the end of Week 1, add the following features: 

 

• A slider that changes the volume of the notes  

• A slider that changes the tempo (speed) of the note sequence 

• A slider that changes the lengths of the notes, from staccato (short and clipped, to legato (long and 

sonorous) 

• A toggle that switches from notes in an ascending scale, to note in a random sequence 

• Some labels that tell the user what things do (e.g. ‘on/off’, ‘speed’ etc.) 

 

 

 

Due: Week 3, 12 noon 

Submission method - you must BOTH: 

(a) be ready to demonstrate your patch at the class, AND: 

(b) compress your patch (as a .zip file) and submit it via Blackboard 

 

Marks will be reduced for late or incorrectly formatted work. 
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Introduction to Max/MSP 

WXK1015 

Semester 1 

Week 2 - Working with audio 
 

Max and MSP 

Max/MSP is really two parts. Max is the part that handles numbers, messages, MIDI information 

and other data. MSP handles audio signals. (There is also a third part called Jitter which handles 

video signals, not covered in this module. Note: Max/MSP is often just referred to as ‘Max’ for 

short!) 

Max and MSP are used together seamlessly in ‘Max/MSP’, but it’s often helpful to understand the 

distinction. For example, the manuals for Max and MSP are separate. Also, MSP objects use a lot 

more CPU (computing power) than Max objects, and knowing that can help you write programs 

that don’t make the computer work as hard. 

The most obvious difference is in making connections. Max connections carry numbers and other 

data, whereas MSP connections carry audio signals. Max number and messages go at a slower rate 

intended for MIDI notes (the ‘scheduler rate’) whereas MSP audio signal numbers go at the much 

faster audio sample rate.) 

You can easily tell the difference between Max and MSP connections when building your patch. 

Max connections are simple black lines (which you can colour) but MSP connections are thicker 

stripy lines.  

You can also tell the difference between Max and MSP objects. 

MSP objects always have the symbol ‘~’ at the end of their name. 

Sometimes that distinction is crucial to avoid confusion. For 

example, the Max object cycle is completely different from and 

unrelated to the MSP object cycle~. However, Max/MSP helps 

you get it right, because it only lets you make the right kind of 

connections. For example, you can’t connect an signal cable to 

cycle, because it is not an audio object. 

Some MSP audio objects 

cycle~    a sine-wave oscillator  

scope~   an oscilloscope for looking at signals  

EZDAC~  a simple audio output object, with graphic on/off button 

gain~   a graphic-based signal level control 

*~   a multiplication object for audio signals (NB: * is for numbers) 

spectroscope~  a spectral signal scope 

 

Some Max objects 

message  a simple container for any kind of data  

int   an integer number 

float   a floating point number 

slider   a graphic fader control for numbers 

line   a ramp (or envelope) generator. (Also line~ for signals) 
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A simple patcher using cycle to generate a sine wave. Pitch can be controlled by clicking and or 

dragging the three objects at the top of the patch. 
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Introduction to Max/MSP 

WXK1015 

Semester 1 

 

Week 3 - Numbers, messages and lists 

 

 
A lot of what Max/MSP does is to do with numbers. Numbers can be musical parameters, MIDI 

notes, control messages, audio signals – in fact, almost anything. So understanding how to work 

with these numbers is really important. 

 

 

 

 
 

 

Number boxes 

Number boxes are the work horse of Max/MSP. When we send a number into a number box, it is 

displayed in the box, and also sent out of the outlet. This allows us to see what is going on in our 

patch. You can also use number boxes as controls for the user, as their contents can be changed by 

scrolling with the mouse, or typing in values directly. 

 

Ints and floats 

There are two kinds of number boxes, int and float. Int uses integers and float uses floating point 

numbers. If we send a floating point number into an int box, the number will be rounded to the 

nearest integer. 

 

Messages 

Messages are pieces of text. A number box doesn’t respond to most messages. However, if we send 

the message ‘set 5’ to a number box, the box will be set to the number 5 BUT THE NUMBER 

WILL NOT COME OUT OF THE OUTLET. This will be very important to remember later on! 
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Variables 

We can use variable in messages using the $ sign. When we include the symbol $1 in a message, 

then send a number into the message, the number replaces the $1 symbol, and the whole message 

comes out of the message outlet. For example, if we make a message box containing the text “My 

house has $1 mice” and send the number 5 into it, the message “My house has 5 mice” will be 

produced. (We can check this using the print object, which sends its output to the Max error 

window.) 

 

Symbols 

A ‘symbol’ in Max/MSP is one ‘nugget’ of information, that may have a number of different 

elements within it. This is a really, really important idea to grasp. The following example should 

help: If we make the message “My house has $1 mice and $2 bats” we can substitute two different 

numbers. BUT if we connect two number boxes, it won’t work. Each number box will substitute 

only the $1 argument, because each number is a different symbol (a symbol containing one 

number). To make the two numbers substitute $1 and $2 resepctively, we need to make a single 

symbol containing the two numbers. We do this by putting the two numbers into message box. So, 

A MESSAGE CONTAINING TWO OR MORE NUMBERS IS ONE SYMBOL. 

 

Lists 

It is possible for a message to contain more than one symbol, if we put a comma. A comma 

separates one symbol from another, and creates what is called a ‘list’. The elements in a list are 

separate symbols, and get sent sequentially, one after the other, whereas elements in a single 

symbol get sent together. 

 

Pack 

Sometimes we have two or more number boxes, but we want them to behave like a single symbol 

(for example, to substitute for the arguments $1 and $2 in a message). We can make the two 

numbers into a symbol by using the object pack. We can put many numbers into pack if we want – 

the argument to pack is the number of inputs we want. If we want pack to handle floating point 

numbers, we should supply floats as the initial arguments. (NOTE: a feature of pack is that the 

symbol we are creating only gets output when the leftmost input is received. If we want to create an 

output when any input is received, we must use the related object pak.) 

 

Unpack 

There is a corresponding object unpack which can do the opposite of pack. Its input is a single 

symbol containing a number of elements, and its output is those elements coming out of separate 

outputs. Using a combination of pack and unpack can be very convenient, because we can send 

many different values down one single connection. We pack them together at the start, send them 

down one connection, then unpack them again at the end. Pack and unpack can handle messages as 

well as numbers. 

 

Avoiding ‘Stack overflow’ 

Sometimes we might want to connect objects in a loop. For example you might have a slider 

connected to a number box, and you want the user to be able to use the slider or the number box to 

control the patch. You want moving the slider to cause the number to change, and you want 

changing the number to cause the slider to move. BUT when we connect objects in a loop, we get 

what is called ‘stack overflow’. When this happens Max/MSP will stop working until we get it 

going again. The way to avoid this is to use the ‘set’ message. When we put ‘set’ before a number, 

we change the value of an object WITHOUT CAUSING THE VALUE TO BE OUTPUT. This 

little fact avoids the continuous loop problem. 
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Send and receive 

Sometimes patches get very tangled with lots of cables. We can avoid this by using the objects send 

and receive (or s and r). For example, if we create the object ‘send gaga’ and another object 

‘receive gaga’, we create an invisible connection. Anything we send input to ‘send gaga’ will be 

output from ‘receive gaga’. (NOTE: there are also signal versions of send and receive. These are 

called send~ and receive~, but CANNOT be abbreviated to ‘s~’ and ‘r~’.) 

 

Continuous controllers and pack 

Pack can be used for continuous controller data. (This is very fast sequences of number that create 

the impression of a continuously changing shape, such as the loudness envelope of a sound.) So, for 

example, if we were using line to create a continuous loudness curve, we could pack this data along 

with other data, and then unpack it again to separate it out from that other data. Lists as input to line 

Because elements in a list get sent one after the other, line can take a list as input and to create a 

continuous controller which has a more complex shape in time. For example, we can say “0, 100 

1000, 50 1000, 200 1000”, which will create a continuous line that goes from 0 to 100 in 1 second, 

then 100 to 50 in 1 second, then from 50 to 200 in 1 second. Note carefully where the commas 

come. The message is a list of four symbols, and three of the symbols contain pairs of numbers. The 

pair is a value and a time. 
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WXK-1015 Introduction to Max/MSP 

Coursework 2 

5% of total module marks. 

 

Create a patch that generates an audible tone with the following features: 

 

 Sound can be switched on and off by a toggle. 

 

 Use of cycle~ and phasor~ to make a composite tone 

 

 Variable pitch of the cycle~ and phasor~  objects controlled by a number box. 

 

 Volume controlled by a gain~ slider 

 

 Use of line to create an automated fade up on the gain~ slider. 

 

 

Due: Week 5, 12 noon 

Submission method - you must BOTH: 

(a) be ready to demonstrate your patch at the class, AND: 

(b) compress your patch (as a .zip file) and submit it via Blackboard 

 

Marks will be reduced for late or incorrectly formatted work.
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Introduction to Max/MSP 

WXK1015 

Semester 1 

Week 4 – Programme flow and control 

In a computer programme (which is what a Max/MSP patch is), events and actions are connected 

together in particular orders, and in cause-and-effect relationship – one thing leads to another. This 

is called ‘flow of control’ (or ‘control flow’). Max/MSP’s visual metaphor gives a very clear picture 

of the flow of control. An important control object is trigger (which can be abbreviated to t). 

Trigger can make a number of events happen in response to any event arriving at its inlet, and it 

allows you to determine the order of the triggered events. A kind of opposite of trigger is select (or 

sel). This looks for specific events, and produces a bang when it sees one. (select can look for 

multiple events!)  

 

Debugging your flow of control 

Debugging means finding and fixing problems. Sometimes it is not completely clear where the flow 

of control in a patch is – which events are happening in what order. This can make finding problems 

difficult. To get round this we can use ‘watchpoints’ and ‘breakpoints’. We add these to 

connections using the right button menu. Watchpoints allow us to see what is going on in a 

connection. There is a special Watchpoints window we can use to see this information. There is also 

a Debugger window that will show us more information – but to use this we need to enable 

debugging (in the Debug menu). Breakpoints are similar, but they actually stop the patch working, 

freezing it in time so we can look at what’s going on. You have to use ⌘u to step the patch forward 

to the next breakpoint. Breakpoints also appear in the Watchpoints and Debugger windows. 
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Event order revisited 

Many problems in Max patches are to do with event order. For example, in maths the sum (2 * 3) -1 

is not the same as 2 * (3 – 1): the order of the calculation makes a big difference. Similarly in 

Max/MSP event order often makes a big difference. In Max/MSP events happen from right to left, 

and from top to bottom. And when events are connected in a chain, the whole chain of events is 

executed right to the end, before any other events are executed. This is the case even if the chain 

wanders around on the screen from left/right or up/down. What counts is the position on the screen 

of the first object. Once that object has been triggered, the whole chain will execute. If there are 

branches in the chain, the rightmost branch is executed first. For this reason it is important to keep 

your patch well organised. 

 

Using line~ to make envelopes  
In this example we need to give all the sine tones the same attack/decay ‘envelope’. You do this 

using line~, which produces a signal ramp. This ramp is a signal going smoothly from 1.0 to 0.0, 

representing the loudest and quietest parts of the sound. We can control the shape of the ramp by 

using a message box to line~. For example, the message 0, 1 500 0 2000 means ‘Start at 0.0, then 

go gradually to 1.0 over a period of 500ms, then go back to 0.0 over 2000ms’. This whole shape is 

called the ‘envelope’, and it is generated as soon as we click on the message box. Now, if we take 

the outout of line and multiply it with our audio signal (using the *~ object), then the loudness of 

our signal will change. It will start off silent, then get louder over 500ms, then get quieter again 

over 2000ms, finishing as silence. We call 500ms the attack time and 2000ms the decay or release 

time. If we want the attack and decay times to be variable, we could change the message to 0, 1 $1 

0 $2. Then we could put two number boxes into pak, and send this into the message box. One 

problem, though, is that the ramp will be triggered every time we change the number boxes. To 

prevent this, we could send the output of pak into the right inlet of another message box so that the 

two numbers are ‘stored’ there. Then we can send this message into the first message box (the one 

with $1 and $2). Now when we click on the second message box (the one with the two numbers) 

the envelope will be triggered. 
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Introduction to Max/MSP 

WXK1015 

Semester 1 

Week 5 – Making patches simpler 

Patches can quickly become very complex. An important way to control this is encapsulation. 

Encapsulation allows us to place complex parts of our inside another object called patcher or just 

p. For example, suppose we want a sine generator with frequency and amplitude controls, and 

stereo phasing. This has quite a few bits to it.  

 

 

 

We do this by selecting the bits of our patcher we want to encapsulate and typing shift-⌘-e. This 

puts everything into a new object, to which we can add a name if we wish (we don’t have to, but it 

makes things clearer). If we encapsulate a group of objects which are connected to objects which 

we are not encapsulating, the new p object will automatically have inputs and outputs which allow 

these connections. If we double click the p (in locked mode) then we can see inside it. You will 

notice that the inputs and outputs are represented by special input and output objects. These are 

how the stuff inside the p communicates with the rest of the patch. You can use the info page of the 

send and receive to label them using the ‘comment’ field, so that when you hover the mouse over 

them you get a message telling you what kind of data you should connect. You can also use send 

and receive to get stuff into and out of a p object, without using input or output objects. 
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Object-Oriented Programming (OOP) 

If we think things through properly, we can make p objects that represent a complete ‘chunk’ of our 

programme function. This makes things simple, because we can then forget about what’s inside the 

p object – we just have to know that it works. (This is an example of ‘Object-Oriented  

Programming’ or OOP.) Let’s take the example of the sine generator we made for Exercise 2. Each 

sine can be thought of as a simple task: we supply a frequency and amplitude, and we get out a sine 

wave as a stereo signal, with the right side 1Hz higher in frequency than the left. So we can 

encapsulate the whole process of generating the sine wave, ending up with a p object that has just 

two inputs (frequency and amplitude faders) and two outputs (the stereo signal). We could call the p 

object p sine_machine … 

 

Before and after encapsulation 

In our sine generator object, we needed 16 of these objects. We could do this by simply copying the 

p sine_machine object 16 times. NOTE: If we do this, any changes we make in one p 

sine_machine object will not affect any other p sine_machine objects, even though they have the 

same name.  

 

Abstractions 

This p sine_machine object is actually quite useful. We can see how we might want to use it again 

and again in other patches. To do this, we can save it as a separate patcher, which we can use in 

other patchers just as if it was a standard Max object. An object like this is known as an 

abstraction. Simply open the p sine_machine patcher, then choose save, and give it a unique name 

(for example, EW_sine_machine). Provided we save it in the Max search path (more on that 

below) we can then use this new object in any patch simply by creating a new object box called 

EW_sine_machine. 

 

 

Abstractions with arguments 

With standard Max objects, we can use arguments (for example, cycle~ 400 is the cycle~ object 

with the argument 440). Abstractions can also take arguments, just like normal objects. To do this 

we put the symbols #1, #2 etc. in our abstraction wherever we want the arguments to be used (so #1 

will take argument 1, #2 argument 2, and so on). These symbols will then be replaced with the 

arguments supplied when using the abstraction. For example, we could make it so that the initial 

frequency could be specified using an argument. We could do this by supplying the symbol #1 as 

the argument to cycle~ inside our abstraction (so, we make the object cycle~ #1 inside our 

abstraction, then save it). When we use the abstraction in our patch, we could supply the argument 

440 (so, we type EW_sine_machine 440). Inside the abstraction, the #1 automatically gets replaced 

by 440, so the cycle~ object now says cycle~ 440. (You can double-click on the abstraction within 

your patch to check if this is the case.) In this way you can build up your own personal library of 

useful objects. You can also download other people’s abstractions from the internet. 
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VERY 

IMPORTANT: File 

preferences and the 

search path 

Abstractions are 

separate files from 

our main patch, so 

when we use them 

Max needs to know 

where to find them 

so that it can load 

them properly. To do 

this Max will look in 

certain places on the 

compute, and these 

places are specified 

in the ‘search path’. 

You can check the 

search patch by 

choosing Options > 

File Preferences… 

You can edit the 

search path by 

adding folders in this 

window. It is a 

really, really good 

idea to add your own 

personal Max folder 

(where you keep 

your work) into the 

search path. 

 

VERY, VERY, VERY IMPORTANT: Include dependencies when you hand in your patch If you 

make your own abstractions, you need to remember that your patch will not work without them! 

 

That means that when you submit your work, you need to submit the abstractions along with 

the main patch. This also applies to other files that may be needed to make your patch work – for 

example, sound files that it may need to load. Abstractions, or other files which are needed for a 

patch to work, are known as ‘dependencies’. It is a good idea to place a comment in your patch 

which lists its dependencies. That way you can make sure you don’t forget to include them. 

When submitting your patch, put it in a folder along with any dependencies, then ‘archive’ 

the whole folder. This will make it into a single .zip file which you can submit. 
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WXK-1015 Introduction to Max/MSP 

Coursework 3 

5% of total module marks. 

 

Create a patch for audio playback with the following features: 

 

 Use of groove~ and buffer~ to enable audio playback. 

 

 The patch must be capable of playing audio at a variety of speeds both forwards and 

backwards. 

 

 

 The patch must be neat and clearly commented throughout. 

 

N.B. You will need to include any audio files in the .zip file of your submission! 

 

 

Due: Week  8 12 noon 

Submission method - you must BOTH: 

(a) be ready to demonstrate your patch at the class, AND: 

(b) compress your patch (as a .zip file) and submit it via Blackboard 

 

Marks will be reduced for late or incorrectly formatted work. 
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Introduction to Max/MSP 

WXK1015 

Semester 1 

 

Week 6 – Playing audio samples 

 

 
 

groove~ and buffer~ 

 

There are a number of objects designed for playing back sound files and audio samples. Each one 

works differently, and is designed with different purposes in mind. The best one for playing back 

shorter samples on a keyboard is called groove~. 

 

Like many of the other sampling and sound file objects, groove~ always needs another object called 

buffer~. Buffer~ is where the sound is actually stored, groove~ is the object that plays the sound 

back by accessing buffer~. In a way buffer~ represents a place in the computer’s memory (RAM) 

where the sound is stored. 

 



Introduction to Max/MSP WXK1015.    Contact - ed.wright@bangor.ac.uk                             Page 18  

 
 

Buffer~ takes two main arguments. The first is the name of the buffer~. This name can be anything 

(for example drum_loop007). We will use the name to link the buffer~ and the groove~ - they do 

not need to be joined by a patch cord. The second argument to buffer~ is the name of the sound file 

we want to load. This can be any AIFF or WAV file, up to four channels. But it must be in the 

Max/MSP search path (which you can set by going to Options->File Preferences). You can click 

on the buffer~ object to see the waveform of the sound it contains. To use groove~, we simply 

supply as an argument the name of the buffer~ we want to access (for example, veggie_sausage). 

The second argument to groove~ is the number of output channels we want (typically two for 

stereo!). 

 

Making groove~ work 

 

Groove~ has two main inputs which both go into the first inlet. The first input is an int or float 

which starts the playback. This number represents where in the audio file to begin playing back. 0 

means ‘play from the beginning’. 1000 means ‘play the sound from 1second onwards (i.e. 1000 

milliseconds thus missing out the first 1second)’. 

 

The second input to groove~ is a signal. This represents the speed of playback. 1 means normal 

speed, 2 means double speed, 0.5 means half speed, and so on. You can vary this signal in real time. 

(NOTE: it is the fact that the two inputs are different types – signal and float/int – which means we 

can send them to the same inlet to do different things.) 

 

Playing backwards 

 

If we supply -1 as the speed signal (or any negative number) the sound will play backwards. BUT to 

do that we can’t start the playback at the beginning of the file i.e. 0 ms – that would mean ‘start at 

the beginning and play backwards’ which clearly isn’t going to work! To make it work, we need to 

specify the end of the sound as the play to start (in ms). To do this, we need to know how long the 

sound is, and we can find this out using info~. 

 

Using info~ to get buffer~ information 

 

The argument to info~ is the name of a buffer~ object (in this case, drum_loop007). If we bang 

info~ it gives us all sorts of information about the sound contained in the buffer~, including how 

long it is. Once we have obtained this number, we can use it as an input to groove~ to start the 

playback, with a negative speed signal. Then the sound will play from the end to the beginning. 

 

Looping 

 

Because groove~ is intended mainly for sampling-keyboard type applications, it has a built-in loop 

function. You can set the loop start and end points (in ms) by supplying them to the second and 

third inlets. Looping is turned on and off by sending the message loop 1 or loop 0 to the first inlet. 

(1 means ON, 0 means OFF – SO…… you can also use loop $1 with a toggle). 

 

Changing buffer~s 

 

If we want access to several samples at once (for example, to have different sounds on different 

tracks, or at different parts of the keyboard), we just use several buffer~s. We can change which 

buffer~ a groove~ object refers to by using the message set drum_loop009 We can do the same 

with the info~ object, to get information on different buffer~s. 
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One nice trick is to use an on screen menu to change sounds. To do this we use a umenu object. In 

the info window of umenu you can type a list of menu messages separated by commas (for example 

drum_loop007, drum_loop009). When you use the menu, this message gets sent out of the 

MIDDLE outlet of umenu. We could then send this output to a message box containing set $1, and 

send this to both groove~ and info~. Then by changing the menu selection, we can change the 

buffer~ these objects are referring to. 

 

Loading new samples 

 

There is no fixed relationship between the name of the buffer~ and the sound file it contains. We 

can change the sound file at any time. To do this we send the message replace. This will open a file 

selector so we can change the sound file. For example, we could load the sound file 

big_explosion007.aif into the buffer~ drum_loop009. NOTE: this means when we choose the menu 

item drum_loop009, we will now hear the sound big_explosion007. This is an important point – the 

name of the buffer~ is NOT necessarily the name of the sound file it contains. 
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Introduction to Max/MSP 

WXK1015 

Semester 1 

Week 7 – Reading week 

 

(No Lecture) 

 

Suggested Reading. 

 

Boulanger, Richard Charles, and Victor Lazzarini. The Audio Programming Book. Cambridge, MA: 

MIT, 2011.  

 

Cipriani, Alessandro, and Maurizio Giri. Electronic Music and Sound Design: Theory and Practice 

with Max/MSP. Rome: Contemponet, 2010.  

 

Roads, Curtis. The Computer Music Tutorial. Cambridge, MA: MIT, 1996.  

 

"Cycling '74: Innovative Software." YouTube. YouTube, n.d. Web. 23 Aug. 2012. 

<http://www.youtube.com/user/cycling74com>. 

 

"Max 5 Help and Documentation." Max 5 Help and Documentation. N.p., n.d. Web. 23 Aug. 2012. 

<http://cycling74.com/docs/max5/vignettes/intro/docintro.html>. 

 

"Object Thesaurus." Object Thesaurus. N.p., n.d. Web. 23 Aug. 2012. 

<http://cycling74.com/docs/max5/vignettes/thesaurus/thesaurus.html>. 
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Introduction to Max/MSP 

WXK1015 

Semester 1 

Week 8 – Simple MIDI control 
 

What is MIDI? 
 

MIDI is a communications protocol for music. It enables music devices, such as sound modules, 

music keyboards and computers, to ‘talk’ to each other. It was originally developed to send 

information about a musician’s performance on a piano-style keyboard, and the protocol reflects 

this: for example, the loudness of a note is called ‘velocity’, because it represents how fast the key 

is pressed down. MIDI is now used much more widely, however – for example, for communication 

between a software sequencer and a software sampler, or for conveying fader movements from a 

hardware mixer control surface to a computer-based Digital Audio Workstation (DAW). MIDI is 

beginning to be replaced by other, more powerful protocols, such as OSC (Open Sound Control), 

but is still the most widely used at the moment. 

 

VERY IMPORANT: MIDI does not ‘contain’ any sound, it is just information about ‘notes’ and 

other musical data. MIDI is like a musical score – useless without an instrument to play it on. The 

‘sound’ of MIDI comes from a MIDI device, which may be hardware (a sound module, for 

example), or software (a software-based sampler on the computer). You therefore cannot ‘listen’ to 

a MIDI file without some device to play it on. It may seem that you can listen to a MIDI file (for 

example, MIDI files that you can find on the internet) but in reality these files are using your 

computer as the instrument on which to play their information. SO: MIDI DATA DOES NOT 

REPRESENT SOUND! 

 

midiin and midiout 
 

STILL IMPORTANT: MIDI information is individual numbers, not audio signals, so it is handled 

using Max objects, not MSP objects. Max provides a number of objects for handling MIDI. The 

simplest way to get MIDI into and out of Max is to use the objects midiin and midiout. 

 

To use these objects we have to specify how the MIDI is actually getting in and out of the 

computer. If you double click on midiin or midiout you will see a list of possible ‘ports’ (ways into 

and out of the computer) and MIDI ‘devices’ (bits of hardware that send or receive MIDI). What 

appears in this list depends on how the computer has been set up using the Audio MIDI Setup 

application (Mac). 

 

AU DLS 
 

For simple testing of MIDI patches we don’t need an external sound module, since there is one built 

in to the computer. On the Mac this is called AU DLS. Its sounds are not very good, but it’s ok for 

quick testing. Select AU DLS as your output device to use it. 
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MIDI channels 
 

MIDI is designed so we can have a complex set-up with different instruments playing on different 

tracks independently. To stop the data for the different instruments getting mixed up, each data 

stream is assigned to a different channel. You can think of this like a TV channel: all the TV 

channels arrive at your house at the same time, but you can choose which channel to actually watch. 

In the same way each MIDI device can be set to ‘watch’ MIDI data on a particular channel, and 

ignore the rest. 

 

Handling MIDI data 
 

If we select an input port for midiin, then play an attached MIDI keyboard, a complex series of 

numbers appears at midiin’s output. This is a MIDI data stream, and it is made up of 8-bit numbers 

(that is, numbers in the range 0 to 127). This stream contains all the MIDI data being sent, on all 

channels, including things like pitch wheels and volume pedals, and so can be complex to manage. 

To help us do this there are special objects which just deal with specific MIDI messages. We would 

normally use these instead of midiin and midiout. 

 

midiin and midiout 
 

Two such objects are notein and noteout. These are very similar to midiin and midiout, and like 

them we have to double click them to set their ports. But they only respond to MIDI note 

information, and ignore everything else. notein has three outlets, all producing numbers in the 

range 0 – 127. These are the pitch of the note (also called ‘note number’), the loudness of the note 

(also called the ‘velocity’) and the MIDI channel. 

 

kslider and nslider 
 

It can be hard to make sense even of this limited set of data, but there are more objects to help us. 

One of these is kslider, which is a keyboard-like display. This can take input directly from notein 

and display it. You can also ‘play’ it using the mouse. Another is nslider, which shows a simple 

form of musical notation. 

 

noteout works like notein in reverse: it has three inlets, for pitch (note number), velocity and 

channel. The leftmost input (pitch) triggers the note, which is not always convenient. To make 

things easier, you can instead send both pitch and velocity as a list to the leftmost inlet. 

 

Note-off nightmare 
 

You will notice that there is no way to specify the length of a note. This is because of the way MIDI 

works – remember it was originally intended to be used while playing a keyboard, so it works in 

terms of note-on events (a key is pressed, the sound starts) and note-off events (the key is released, 

the note stops). The length of the note would be determined by the keyboard player, holding down 

the key for a certain length of time. Therefore you cannot specify the length of a note in the note 

data. 

 

A note-off event is simply a note-on event, but with velocity zero. If we start a note C3 with 

velocity 64 on channel 1, that note will play for ever until we send C3, velocity 0, channel 1. If we 

send velocity 0 for note D3 instead of C3, or send it on channel 2 instead of 1, that’s no good – our 

original note will stay ‘stuck’ on. This makes managing MIDI notes really hard when we are doing 
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ourselves from within Max, because we have to have a way of remembering which notes are on, 

and turning them off at the right moment. 

 

To help us with this Max has a makenote object. This object is allows us to specify a note duration, 

and it takes care of sending the note-off messages itself. We can supply velocity and duration 

arguments to makenote, and just send it pitches, or you can send velocity and duration to its inlets, 

or you can send a pitch velocity duration list to the left inlet. 

 

Program change messages 
 

Another very useful object is pgmout. This sends a programme change message, which tells a 

MIDI device to play a different sound. Like midiout and noteout, pgmout has to be set to a certain 

port or device. We send pgmout a number to change the sound played by that device. Most devices 

can play more than one sound at a time, on different channels, and we can send pgmout a number 

saying which channel we want to change the sound on. So, we could use sound 5 on channel 1, 

sound 14 on channel 2, and so on. Then when we send note information on these different channels, 

they will play with different sounds. 

 

Using umenu 
 

WE have used umenu before to select different samples to play. In the same way we can us umenu 

to select input and output devices, and to set programs and sounds. This is much more convenient 

for the user. We can connect the first outlet of these umenus to our midi objects (such as notein 

and pgmout). 

 

For selecting programs and sound, we have to populate the umenu manually: that is, we have to 

find out that sound number 1 on the device is ‘piano’ (for example) and write ‘piano’ into the menu, 

then put ‘strings’ as the second umenu item, and so on. 

 

For selecting MIDI devices 

and ports, we can populate 

our umenu automatically. To 

do this we use the midiinfo 

object, which we connect to 

the input of umenu. If we 

then send midiinfo a 1, it will 

fill our umenu with a list of 

input devices and ports, and if 

we send it a 0 or -1, it will 

give us a menu list of output 

devices. 
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Help with Exercise 4 

 

In Exercise 4 you have to convert MIDI notes to groove~ playback speed. This is tricky, because 

musical notes use a non-linear scale, the 12th root of 2. This is because one octave higher (12 

semitones) doubles the note’s frequency (and playback speed), and one octave lower halves it. This 

doubling every 12 octaves has to be split evenly between all the twelve semitones in the octave, 

hence the use of the 12th root of 2. The easiest way to use the 12th root of two is as a constant, which 

is 1.05946309. 

 

So it we start with a number (a frequency in Hz) then times it by the 12th root of 2 (1.05946309), 

then do it again, then again… – until we’ve done it 12 times, we will end up with the double the 

original frequency. In other words, going up 11 semitones will double the frequency… 
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WXK-1015 Introduction to Max/MSP 

Coursework 4 

5% of total module marks. 

 

Create a sampler patch with the following features: 

 

 Audio can be triggered by the MIDI keyboard. 

 

 The keyboard must control audio playback speed and pitch in a coherent manner, for 

example when you play an octave up the keyboard audio must come out an octave higher. 

 

 The patch must use a buffer~ object and allow the user to load new sounds. 

 

 The patch must be neat and clearly commented throughout. 

 

 

 

Due: Week  10 12 noon 

Submission method - you must BOTH: 

(a) be ready to demonstrate your patch at the class, AND: 

(b) compress your patch (as a .zip file) and submit it via Blackboard 

 

Marks will be reduced for late or incorrectly formatted work. 
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Introduction to Max/MSP 

WXK1015 

Semester 1 

Week 9 – Enveloping and cross-fading 
 

As we have seen before, an envelope describes the way a sound changes over time. Up to now we 

have used loudness envelopes, but you can have envelopes controlling other things as well. 

 

Line~ 

 

The objects for creating envelopes are line and line~. line~ has the advantage that it can create 

multi-stage envelopes – that is, the line can co up and down several times in different way (up to 

128 times). 

 

line~ is triggered with a message box, which in turn could be triggered by note information from a 

keyboard or sequencer – so every time we play a note, we also get an envelope. The message gives 

a starting value followed by a comma. After that, we put pairs of numbers – a value and a time in 

milliseconds. The value is ramped to gradually over the given time. In order to make the parts of the 

envelope variable, we can use $1, $2, $3 etc., instead of fixed values, and supply variable values 

sent through a pak object. One problem with this approach is that the line~ gets triggered whenever 

we adjust one of the variables. To prevent this, we can store the values until we are ready to trigger 

them. We do this by sending the output of pak into the right inlet of a message box, then banging 

the message to trigger line~. 

 

 
 

Curve~ 

 

Sometimes we don’t want straight lines, but curves. This is especially true with loudness envelopes. 

Our perception of loudness is not linear, but logarithmic. (Every 6dB of extra gain doubles the 

Sound Pressure Level or voltage, while every 10dB extra gain doubles the perceived loudness.) 

This means that to achieve an even fade in or fade out, we have to use a logarithmic curve. We also 

need curves if we want to crossfade one sound with another – if we used straight lines, we would 

hear a dip in loudness in the middle of the crossfade (this is called an ‘equal power crossfade’). 

 

The curve~ object is like line~, except that it can generate curves. Instead of two points (value and 

time) we must supply three (value, time and curve shape). The last value is between +1.0 and -1.0, 

with a minus value giving a positive curve, and a plus value a positive curve. For example, to do a 
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500ms crossfade, we would fade out the old sound using 1, 0 500, 0.5, and at the same time fade in 

the new one with 0, 1 500 -0.5 
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Introduction to Max/MSP 

WXK1015 

Semester 1 

Week 10 – Designing the user interface 
 

The User Interface or UI 

 

Up to now we have been making patches that we have been using ourselves. But Max/MSP is a 

great way to make software for others to use. When we do that, we need to consider how we design 

the ‘look and feel’ of the User Interface or ‘UI’ (that is, the various buttons and sliders on the 

screen, and how they all work together to control the patch). 

 

Because Max/MSP is graphical, it is easy to change the appearance of many aspects, and arrange 

the UI just how we want it. 

 

Some hints and tips on UI design 

 

 Don’t assume a knowledge of Max/MSP – your patch should be usable by someone who 

has never worked with Max/MSP. It should also be usable in ‘locked’ mode only. 

 

 Be consistent – for example, if you use a graphic button for one switch, don’t use a toggle 

for another 

 

 Word your messages and labels clearly – we all know how frustrating it is when a 

program says ‘Exception raised line x20df45, error -3878’. Say what you mean! Use the 

correct but simplest music technology terms (‘output level’ is better than ‘amplitude’) 

 

 Use color appropriately – don’t go crazy with rainbow colours. Choose a colour scheme 

and stick to it. Look at commercial software to get some ideas. Always put light coloured 

text on a dark background, and vice versa. 

 

 Make the interface intuitive – the user should be able to guess how to do things a lot of the 

time 

 

 Don’t clutter up the screen – a simple screen is more attractive and easier to use than a 

cluttered one 

 

 Group functions together – functions that belong together should be near each other on the 

screen (for example, ‘play’ and ‘record’) 

 

 Give the user feedback – the user should be able to see what is going on when they use the 

software, through things like number displays, signal meters and the appearance of buttons 

(pressed/unpressed) 

 

 Get someone else to test your patch – things may seem obvious to you, but what about 

someone who doesn’t know how you have made the patch. Can they use it easily? Ask them 

to tell you how they found it. 
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‘Color’ messages 

 

Nearly all objects can be coloured using the standard Max/MSP color messages (NOTE 

AMERECAN SPELLING!). Color messages give values for Red, Green, Blue and Alpha. The first 

three is the amount of each colour in the mix, and you can make any colour by varying those 

amounts. Alpha is the transparency or ‘see-through’ value of the colour. This format for colours is 

known as RGBA, and you can use either floating point values (between 0 and 1) or integers 

(between 0 and 255). Using floating point gives you more precise colour variation (technically, it is 

24 bit colour rather than 8 bit). 

 

There are various messages to set the colour of various components of your objects. For example 

bgcolor followed by RGBA values sets the colour of the background, bordercolor the colour of the 

border, knobcolor… well, you get the idea. Check the object reference for details on each object’s 

colour messages. 

 

Textbutton 

 

Nearly all objects can be coloured using the standard Max/MSP color messages (NOTE 

AMERECAN The textbutton object is very useful for building user interface controls. Unlike a 

simple message box or ‘bang’ button, it can change colour when it is clicked on, and even when the 

mouse is hovering over it. You will often use a textbutton to bang a (hidden) message box. A 

textbutton can also act as a toggle (and it can change its appearance when toggled). 

 

Panel 

 

A panel is just a rectangle that can be coloured in various ways, and given shadows on its edges so 

it appears raised or depressed. Panels are very useful for grouping controls together and making a 

professional looking interface. 

 

Emulating real hardware – pictslider and pictcntrl 

 

Software is often easier to use if graphic elements look like real studio gear. For example, if your 

output control looks like a real fader on a mixing desk, the user is more likely to guess what it is 

for. We can do this by using the pictcntrl and pictslider objects. These can be linked to picture 

files showing a particular fader or knob design, and you can even design these yourself using 

graphic software such as Photoshop of GraphicConverter. You need to know the right format for 

these pictures though – consult the help files for pictcntrl and pictslider. You can even base your 

images on photos of real gear taken from the Web. (hhb.co.uk is a great site for large images of 

studio gear – click on ‘catalogue’.) 

 

Note: pictslider has two axes, so you can use it like a 2d joystick control. But it is also the object 

you need to make a fader. To do this you would turn of ‘Horizontal tracking movement’ in the info, 

then you would have a fader that goes up and down, but not left to right. 

 

Locking the background 

 

Another useful tip is to include some objects in the background. For example, often you want to 

edit elements which lie on top of a panel, without moving the panel itself. To do this, select the 

panel, and choose Arrange->Include in background. Now when you choose View->Lock 



Introduction to Max/MSP WXK1015.    Contact - ed.wright@bangor.ac.uk                             Page 31  

 
 

background the position of the panel will be locked. Choose View->Unlock background to free it 

up. 

 

 

Presentation Mode 

 

Software is often easier to use if graphic elements look like real studio gear. For example, if your 

Max/MSP has a special mode called ‘Presentation Mode’. The idea of this is that you put objects in 

different positions when the patch is locked from where they will be when unlocked. This is useful 

because sometimes you need things more spread out when editing your patch, and closer together 

when the user is using it. You also sometimes need to lay things one way for the user, and another 

way to make the working of the patch clear when you are building it. 

 

To go into Presentation Mode, click the small blackboard icon at the bottom of the patcher window. 

At first all your objects will disappear, but that’s because you don’t yet have any objects in the 

presentation. To place objects in the presentation, choose an object and select Object->Add to 

presentation. The object will now appear with a pink border. If you move it in Normal mode, then 

change to Presentation mode, the object will jump back to its original position. The same applies of 

you move it in Presentation mode. Working like this can be very powerful – but you need to 

remember which mode you are in when moving things around! 

 

 

 

 

 



Introduction to Max/MSP WXK1015.    Contact - ed.wright@bangor.ac.uk                             Page 32  

 
 

Suggested Reading. 
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MIT, 2011.  
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with Max/MSP. Rome: Contemponet, 2010.  

 

Roads, Curtis. The Computer Music Tutorial. Cambridge, MA: MIT, 1996.  

 

"Cycling '74: Innovative Software." YouTube. YouTube, n.d. Web. 23 Aug. 2012. 

<http://www.youtube.com/user/cycling74com>. 

 

"Max 5 Help and Documentation." Max 5 Help and Documentation. N.p., n.d. Web. 23 Aug. 2012. 

<http://cycling74.com/docs/max5/vignettes/intro/docintro.html>. 

 

"Object Thesaurus." Object Thesaurus. N.p., n.d. Web. 23 Aug. 2012. 

<http://cycling74.com/docs/max5/vignettes/thesaurus/thesaurus.html>. 
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WXK-1015 Introduction to Max/MSP 

Main Assignment 1 

40% of total module marks. 

 

In Max/MSP create a software instrument, capable of playing back and manipulating pre-recorded 

samples as well as the facility for additive synthesis. 

In addition to this the patch must have a well developed user interface, make use of presentation 

view and be clearly commented when unlocked. 

Credit will also be given to work that fulfils this remit and then further extends this scope (for 

example but not limited to: to include gestural control with a foot-pedal or manipulation of 

synthesis parameters via webcam). 

Marks will be awarded based on the module learning outcomes. 

 

 

Due: Week  13 12 noon 

Submission method - you must BOTH: 

(a) Submit the work on CD in a clear plastic CD wallet NOT jewel case with covering form to 

the MUSIC OFFICE. 

(b) compress your patch (as a .zip file) and submit it via Blackboard 

 

Marks will be reduced for late or incorrectly formatted work. 
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Introduction to Max/MSP  

WXK1015 

Semester 2 

 

 

Weekly plan: 

 

 1 – Breaking down the problem; logic and theory. 

 2 – User interfaces: colours, keyboards and mice. 

 3 – Soundfile playback control and timing.  

 4 – Refining soundfile playback control and timing. 

 5 – More elegant approaches to additive synthesis. 

 6 –*Reading Week* 

 7 – FM synthesis. 

 8– First steps in polyphonic synthesis. 

 9 – A better way to create polyphony: poly~ 

 10 – Breaking out; physical I/O and Arduino. 

 11 – Tutorials 

 12 – Tutorials 
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Introduction to Max/MSP  

WXK1015 

Semester 2 

 

Week 1 – Breaking down the problem; logic and theory. 

 

Basic Positional calculus/logic 

 

Logic can give us a formal way to deal with very complex statements in very simple terms, this is 

not a strictly necessary tool for programming but defines a rigour of approach that can be very 

useful. 

 

 In Propositional Logic, there are two types of sentences -- simple sentences and compound 

sentences.   Simple sentences express ``atomic'' propositions about the world. Compound 

sentences express logical relationships between the simpler sentences of which they are 

composed. 

For example: It is raining as I type this. - simple sentence. 

It is raining as I type this so the dog will get wet in the garden - compound sentences 

 A negation consists of the negation operator ¬ and a simple or compound sentence, called 

the target. For example, given the sentence r, we can form the negation of r as shown 

below. 

¬r 

It is raining as I type this – can be shown as r 

It is not raining as I type this – can be shown as ¬r 

 A conjunction is a sequence of sentences separated by occurrences of the ∧ (and) operator 

and enclosed in parentheses, as shown below. The constituent sentences are called 

conjuncts. For example, we can form the conjunction of r and d as follows. 

It is raining as I type this and the dog is wet. 

It is raining as I type this. – can be shown as r 

The dog is wet. - can be shown as d 

(r ∧ d) 
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 A disjunction is a sequence of sentences separated by occurrences of the ∨ (or) operator and 

enclosed in parentheses. The constituent sentences are called disjuncts. For example, we can 

form the disjunction of r and d as follows. 

It is raining as I type this or the dog is not wet. 

(r ∨ ¬d) 

 An implication consists of a pair of sentences separated by the ⇒ (so) operator and enclosed 

in parentheses. The sentence to the left of the operator is called the antecedent, and the 

sentence to the right is called the consequent. The implication of r and i is shown below. 

It is raining as I type this so the dog wants to come into the house. 

The dog wants to come into the house. – can be shown as i 

(r ⇒ i) 

 An equivalence is a combination of an implication and a reduction. For example, we can 

express the equivalence of p and q as shown below. 

It is raining as I type this so the dog wants to come into the house. The dog wants to come into the 

house so it must be raining. 

(r ⇔ i) 

 For all ∀ defines a group. 

For all cases when it is raining the dog will get wet 

∀ r ⇒ d 

 

 An existential qualification ∃ tells us some thing or some set exists. 

 

There is a wet dog. 
 

∃ d 

 

 Parentheses then help to specify what is happening in order and define statements 

 

It is not raining as I type this, and the dog is dry, so it wants to stay outside. 

((¬ (r ∧ d)) ⇒ ¬ i) 
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Or Truth Table 

a b avb 

T T T 

T F T 

F T T 

F F F 

 

And Truth Table 

a b a∧ b 

T T T 

T F F 

F T F 

F F F 

 

Not Truth Table 

a ¬a 

T F 

F T 

 

Implies Truth Table 

a b a⇒b 

T T T 

T F F 

F T T 

F F T 

∧ and 

∨ or 

¬ not 

⇒ implies 
∀ for all 

∃ there exists 
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Chunking 

 

When creating a patch we often have an idea of what we want it to do. This may be as simple as ‘be 

a sampler’ in which case we are wrapping up a number of quite complex concepts into the notion of 

what we understand as ‘sampler’. This can be divided into chunks, an easier example would be to 

make a cup of tea. In this example each line is based on the first element of the previous row, each 

element generates its own tree but it would be too large and cumbersome to recreate here. 

 

Make a cup of tea 

 

 

Boil kettle   put tea in cup   add water  remove tea bag 

 

 

Move to kettle   check for water refill if required turn on heat  

 

 

Check position of kettle movement required? execute appropriate movements 

 

 

Remember where kettle is  look for kettle  check you have a kettle 

 

 

Check memory for what is understood by kettle … and there we will leave it! 

 

In terms of setting out your patch this can be very useful, in that it provides you with a method of 

modelling its development. Your overall patcher must carry out a defined task, within that there are 

several elements (possibly sub patchers) that need to function correctly, they in turn may be 

constructed from separate sub elements or objects and so on. 

 

Nesting 

 

Working at the level of ‘pure’ logic returns us to the idea of chunking. From basic on/off or yes/no 

responses we move into the symbolism of what we are testing. With a simple or gate we could 

make something to test if it is raining.  

 

Is it raining or is it not raining? 

 

This is test is fundamentally very simple but it does bypass the entire issue of what rain is. The or 

operation could only have a meaningful result if it came towards the ‘end’ of a process that first 

defined what rain is.  

 

Within the question there are several nested functions that make up the concept of rain, including 

those of liquid water, droplets, falling from the sky and that it is happening now. 

 

From this perspective nesting of concepts can be seen as almost the reverse of chunking, chunking 

takes a variety of functions and makes them into a single object, nesting builds up ideas inside an 

object. A bit like taking Russian dolls apart or putting them back together again. 
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Implications for working in Max/MSP 

 

 Applying low level objects  

 

There are a number of basic objects that can help us build up this complex picture these include the 

obvious numeric functions such as * / + - but also a number of logical operators such as: 

 

if evaluates input according to a conditional statement specified in an if-then-else form. 

!= Compare two numbers, output 1 if they are not equal. 

== Compare two numbers, output 1 if they are equal. 
 

These can help to break down what can otherwise be a complex set of elements such as if the kettle 

is on then wait for it to boil, else turn it on or if audio in is 440Hz then display ‘A’ else display ‘not 

in tune’. 

 

 Working on paper 

 

The main point of this approach is that it can define a structure to the way that you create patches.  

It means that you can simply define areas and functions within your patch and chunk them. A midi 

sequencer may have several chunked regions such as ‘midi input’, ‘sound-file selection’ and 

‘volume controls’. Whilst creating patches it is not always necessary to know exactly what each 

element does but simply what it is and what its input and output requirements are. This means that 

it is possible to map work out on paper or on screen before you even start max up. 

 

Class exercise 

 

1. Plan out on paper how you would build a patch that plays different pitches when you press 

different letters on the qwerty keyboard. The timbre must change when the shift key is 

pressed (i.e. you are typing in UPPERCASE). This can take the form of a flow diagram or 

bullet points, but does not need to include all the objects of your patch, just how the various 

elements inter-relate. You can refer to the max help file if required. 

 

2. Build it and test it. 
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Introduction to Max/MSP  

WXK1015 

Semester 2 

 

Week 2 –User interfaces: colours, keyboards and mice. 

In order to create successful patches it is important that it is as simple and intuitive as possible for 

the end user. This is can be understood as a dialogue between what comes out of the computer and 

what goes into the computer. At this stage we will be using the monitor as a means of getting 

information from the computer.  

 

The background of a patch is defined by the 

bgcolour object. It has 4 inlets accepting 

RGBA inputs integers between 0-255 or a list 

of values 0-1. In this patcher loadmess is 

sending an initial value of 1 to all the 

number boxes (this is redundant due to the 

arguments in the bgcolour object but is 

included for versatility). pak then 

combines the outputs of the number boxes into 

a list of values for bgcolour. 

The panel object works in a superficially similar way. The main difference is that it has more 

parameters and is therefore controlled by messages as well as numbers. The background colour of 

the panel is defined with a pak list but then requires that list to be prepended with the message 

bgcolour. Other parameters are defined by a message followed by an integer variable signified by 

$1 as in border $1. 

Colour and shape are very useful tools especially when they are reactive to input and can feed back 

information to the user. 
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The keyboard is a simple controller found on almost every computer. It can be monitored with the 

key object. 

 

Likewise the mouse can be monitored with the 

mousestate object. mousestate requires a bang to report 

the position of the mouse. In the case of this patcher the 

metro object is sending a bang every 200ms so mouse 

position is reported 5 times a second. The mousestate 

object has a verity of modes in this case we are using 

mode 2 where position is measured relative to the top 

level window. The outputs are position and delta values 

as well as button on/off 

 

 

It is now possible to know where the user is clicking; however for some situations a ubutton may be 

more appropriate. The ubutton sends data mouse location and button state when clicked making 

simple click control a lot easier. Here it is used in combination with the spacebar (key 32) to change 

and restore the background colour of our window. 

 

Class exercise:  

Create a patcher with a red panel. The panel will turn blue when the 

spacebar is pressed and turn red when the letter r is pressed. When the 

mouse is clicked the background of the patcher will change colour 

depending on the horizontal position of the mouse and opacity (alpha) 

depending on its vertical position.   
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Introduction to Max/MSP  

WXK1015 

Semester 2 

 

Week 3 –Soundfile playback and timing. 

 

 

Encapsulation, abstraction and pianos 

 

When constructing a patch there may be many areas of duplication. In some cases it may be simple 

and effective to copy and paste areas of your patch into other configurations. However this is not 

always very practical. Parts of your patch can be encapsulated and as a subpatch with the patcher 

command, these can be copied and pasted within the main patch. These can be altered and reworked 

as separate entities but remain inside the main patch. Further to this patches can be saved as 

abstractions. These objects are available to use inside any patch, as long as they are in Max’s search 

path. Using them is almost indistinguishable from using standard Max objects. But editing an 

abstraction changes all the instances of it in all your patches, so you need to be careful not to break 

something. You  must be aware which are abstractions you have created and which come with max 

as this can lead to obvious issues when you transfer your file to another machine if you do not copy 

all the information across. 

 

This can be easily visualised in the case of a piano. The strings are activated by hammers. Under 

normal playing conditions we clearly never need more than ten hammers (one per finger). A normal 

piano essentially consists of copied hammers all the way across the stings working in parallel. It 

would be technically possible to build a working piano that used only ten (or maybe less) hammers 

providing each hammer could be called into place as the appropriate key was struck.  

 

bpatcher 

 

Sometimes, we want to make something like a patcher or an abstraction, but that has visible 

controls, like buttons or faders. We want the whole thing – including the buttons and faders, to be 

available to use in all our patches. This is done with bpatcher. 

 

To make a batcher, we simply make a normal Max patch, hiding the elements we don’t want to see, 

and arranging the buttons and controls how we want them. If you want to get data into and out of 

the bpatcher, such as messages from ‘play’ or ‘stop’ buttons, or values of faders, we can do this 

either with input and output objects, or by using send and receive (or send~ and receive~). Then 

save this patch in your Max search path.  

 

Now, to use the bpatcher we have created, we make a new patch and create a bpatcher object. In the 

info inspector we enter the pathname of our previously saved patch (or use the ‘choose’ button). 

Now we can see the previous patch ‘inside’ the bpatcher window in our new patch. You can drag it 

around inside the bpatcher by using <shift><command><click-drag>. 
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Playing soundfiles 

 

MAKE SURE DSP IS TURNED ON! 

 

Up to now you have used groove~ with buffer~ to play back sounds. This is fine for shorter sounds 

such as samples. To playback longer sounds (like whole albums) we use sfplay~. Whereas buffer~ 

loads the whole sound into the computer’s memory for groove~ to play back, sfplay~ plays the 

sound continuously from the hard disk, so we are not limited by the computer’s memory. If we 

want sfplay~ to be stereo, we need to supply the argument 2. For four channel interleaved files it 

would be 4 and so on. 

 

We could use the 

open message to load 

a file, but in fact most 

users want something 

simpler and more 

instant.  To do this 

we can use dropfile. 

This is an invisible 

rectangle – when the 

user drags a file onto 

it, it returns the full 

pathname of that file. 

We can then just send 

this to sfplay~, 

putting ‘open’ on the 

beginning of the 

message. We do this 

by passing it through 

the prepend object 

with the argument 

open. (So, prepend 

open.) 

 

To control playback of sfplay~ we use the messages 1 (play) 0 (stop) pause and resume (resume 

playing after pause). We just have to bang these messages with whatever control buttons we have 

created. These could come from inside a bpatcher using send/receive objects or output objects in the 

bpatcher. 

 

Timing 

 

It would be nice to know where in our soundfile we are. Sfplay~ has an output for this, which is a 

‘timing signal’ or ‘sync signal’. This gives the playback position in milliseconds, but note that it is a 

signal, not an int or float, hence the coloured cable. This means that the timing is sent continuously. 

However, for a time display, we don’t really need it to be continuous – changing it every 10th of a 

second will do. To do this we can use snapshot~. When we bang snapshot~ it gives us a readout of 

the signal, so if we use a metro to do this (say metro 100) we get timing on a regular basis. 
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Having a timer in ms. is not 

very intuitive so here is the 

conversion from first 

principals. 

 

• The first thing we want to 

know is how many hours 

have elapsed. 1 hour = 60 

minutes, = 60x60 seconds x 

1000ms = 3600000ms. So if 

we divide the signal by 

3600000 we get hours. 

 

• The bit after the decimal 

point is minutes (or fractions of 

an hour). To get rid of integer 

and be left with decimal, we 

need to subtract the integer 

from float. There is a clever 

way to do this: expr $f1-$i1 

We send the same number 

into both inlets, but the right 

hand one is forced to be an 

int. So when we do the sum, 

only the bit after the decimal 

point is left. This give tenths of 

hour, so we x60 to get 

minutes. 

 

• Now we have another leftover bit after the decimal point, so we do the same (expr $f1=$i1) to get 

seconds. 

 

• Finally, we take the bit after the decimal again, and x10 to get 10ths of a second. 

 

Now we can send all these results to our display. To do this we need to make the numbers into a 

formatted message. We can use sprintf, which comes from C and C++ programming. It allows us to 

assemble a message just as we want to be formatted (so it’s like printing). We use sprintf %i : %i . 

%i (which means print 3 ints separated by colons). Now we send that to a textedit object for our 

display. We could colour this to look like a neon CD display, or whatever style we want. 

 

Class exercise: 

 

Create a patcher that plays the given audio file. It needs to be able to start, stop and pause and 

display the current file position in hh:mm:ss format. This should all be contained in a bpatcher so 

that it can be used in other patches. 
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Introduction to Max/MSP 

WXK1015 

Semester 2 

 

Week 4 – Refining soundfile playback  

control and timing. 

 

sfinfo~ 

 

With groove~ and buffer~ you were able to use info~ to get information about the buffer (for 

example, its duration). When we are working with sfplay~ to play sound files from disk, we can use 

the similar object sfinfo~. To do this we send sfinfo~ the message open <filename>, which is the 

same message we send to sfplay~. It can be helpful to use sfinfo~ to display the current file’s 

number of channels and duration to the user, possibly using message boxes. 

 

FF and REW 

 

With most playback devices (CD players, mp3 players, sequencers etc.) we have fast forward and 

rewind functions for moving quickly through the sound file or track. We can achieve this with 

sfplay~ by using the seek message. The message: seek followed by an argument means ‘go to x ms 

in the file and start playing’. So seek 0 will play from the beginning. To skip forwards or backwards 

while playing, we just need to get the current playback position, add or subtract a constant value 

(say, 500ms), and use that new value in a seek message. The current playback position is output 

from the sync outlet in sfplay~ (provided that we supply 3 arguments to sfplay~, which are number 

of channels two if working in stereo, buffersize = 0 and number of sync outlets = 1 as covered last 

week). The playback position is a signal, which we convert to a float using number~ (right hand 

outlet). 

 

Scrubbing control 

 

Sometimes it can be useful to have a ‘scrubbing’ control, whereby we can drag a pointer through 

the file to move to any point in it. This is handy both for practical and more creative applications. 

To do this we could use a horizontal slider as the control. We need the length of the slider to 

represent the whole soundfile, so we divide the current playback position (obtained from the sync 

output) by the total file duration (obtained from sfinfo~). That gives  the playback position as a 

fraction of the total (0.0=beginning, 1.0=end). Then we multiply this by the range we have given 

the slider (say 1000). When we’ve worked out this value, we can feed this value directly to the 

slider using the set $1 message, and the slider position will then reflect the current playback 

position. If we want to grab the slider to change the position, we simply reverse the process: the 

slider value divided by 1000.0 (or whatever the slider range is) gives us a new fraction of the total 

duration. We times this by the actual total duration, and send the new value to sfplay~ as a seek 

message.  
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Class exercise: 

 

 Demonstrate your coursework 5 patch. 

 Create a patch that enables you to start, stop and open 

an audio file.  

 Set up a sync outlet from sfplay~ and use number~ to 

give your playback position. 

 Load up some audio into your patcher 

 Use sfinfo~ to find out how long the file is. 

 Use seek $1 and a number box to skip forwards and 

backwards through the file. 

 Make a sub-patcher that has file position and file duration as inlets and an outlet to seek.  

 Connect the sub-patcher to the main patch as described in the previous step. 

 Within this sub-patcher make a scrub tool as described in the handout. 

 Test it! 

 (For extra smugness, try creating a two dimensional fader that controls both scrub position and 

volume from mouse positioning). Hint: pictslider or mousestate may be useful for this. 

 For bonus silliness try it with two instances of sfplay~ i.e. everything duplicated and therefore 

two sound files running simultaneously! 
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Introduction to Max/MSP 

WXK1015 

Semester 2 

 

Week 5 – More elegant approaches to additive synthesis. 
 

Harmonics and partials 
 

All sounds can be thought of as being made up of mixtures of sine tones. We call this the 

‘spectrum’ of the sound, because it is a bit like splitting white light into its component colours. In 

theory, we can simulate any sound by adding sine tones together, although in practice we need very 

many sine tones (at least several hundred), and very complex control over their loudness over time. 

But we can still do quite a lot with just a few sine tones. 

 

As we saw last semester, adding sine tones together to build up a spectrum is called additive 

synthesis. Each sine tone is called a ‘partial’, with the lowest frequency partial called the 

‘fundamental’. In harmonic sounds (like instruments or voices) the frequencies of the partials relate 

to that of the fundamental by whole numbers (2* fundamental, 3* etc.) This is called a ‘harmonic 

spectrum’, and the partials are sometimes called ‘harmonics’. If we don’t use whole numbers we 

have an ‘inharmonic’ spectrum, rather like a bell. We should not call the individual sine tones 

‘harmonics’ in this case – because they are not! 

 

Early experiments with recorded sound showed that when we hear real-world sounds it is not so 

much the mixture of partials that gives the sound its characteristic ‘timbre’, but the way those 

partials change over time. So to make realistic, vibrant and ‘alive’ sounds we need to control not 

just the frequency of each partial, but also its amplitude over time. 
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Generating partials 
 

We now know how to make a 

subpatch and save it as an 

‘abstraction’, which can take 

arguments, and which we can use 

over and over again. Since we want to 

make sounds with many partials, it 

makes sense to design an 

abstraction to generate one partial, 

then re-use this for however many 

partials we want. (NOTE: when 

making this abstraction, it’s fine to end 

the name with ~ if we want. This 

reminds us that it is a signal based 

object.) 

 

The parameters we will supply to our abstraction are: 

 Fundamental frequency in Hz. 

 Multiplier (how many times our current partial is higher than the fundamental i.e. a 

multiplier of 2 would make a fundamental of 440Hz. have a partial of 880Hz.) 

 Amplitude envelope (a series of line break point pairs.) 

 

The fundamental frequency will simply come from the note we want to play. 

 

The multiplier can be supplied as a variable, which can be supplied by a inlet to the object. We can 

also use a number argument in this case 1. until a new variable in supplied. To achieve this effect 

we can use a * object, and give it the argument 1. but we also attach the inlet to the right inlet of the 

* object. So the #1 will be replaced with whatever argument we supply, but if a new value appears 

at the inlet later on, the 1 value will be overridden with the new value. 

 

The amplitude will come from an envelope generator which will provide a list of value/time pairs. 

We can feed these into a line~ object. 

 

The output of the abstraction will be a sine tone. We could send this out using a send~ object. If all 

abstractions use the same send~ and receive~ arguments, they will be mixed together (which is 

what we want). If we want to, we can make the abstraction stereo, with two sine generators in it. In 

this case we would send the outputs via two send~ objects with different names. 

 

When we have made our abstraction, we can put however many we want in a parent patch, and 

supply them with arguments. If we give them simple numbers to start off with (say 1,2,3,4,5,6 etc.). 

we will generate a harmonic sound. If we use complex numbers (1 2.3 4.5 6.6 6.9 etc.) we will get 

an inharmonic sound, rather like a bell. 
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Drawing envelopes 

 

To control the amplitude, we can use a function object. This allows us to draw a trajectory, and use 

this to send values to the line~ object in our partial generator. In our function object the x-axis of 

the function will be the length of our note in ms. We can set this with the setrange $1 message ($1 

being the variable representing how many ms. we want the function to run for . Now if we bang the 

envelope, it will send out x y pairs to line~ and thus control the amplitude of our sine. 

 

Playing 

 

Now all we need to do is add the ability to ‘play’ the sounds. To do simply we can use notein then 

the object mtof can convert MIDI note numbers into frequencies. Functionality can be added by 

including an on screen keyboard and midi selection.  
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WXK1015 

Semester 2 

 

Week 7 – FM synthesis. 
 

FM synthesis 
 

As we have seen, additive synthesis is achieved by adding sine tones together. But we need many 

sine tones for sounds to be interesting. Slightly paradoxically FM synthesis can create complex 

sounds in a much simpler way. The basic idea is take a sine wave oscillator, and use another sine 

wave to continuously change (or modulate) the frequency of the first (hence ‘frequency 

modulation’). Because the controlling oscillator is also at audio frequency, we get ‘interference 

patterns’ between the two signal that create extra partials, and these patterns can be heard as 

additional partials. The pattern of partials created depends on the ratio between the original two 

frequencies. A simple ratio (e.g. 1:2) creates a more simple, harmonic sound. A complex ratio 

creates a complex inharmonic sound. 

 

FM terminology 
 

There are two sine waves. The first is called the ‘carrier’ (the basic pitch of our note) and the 

second is referred to as the ‘modulator’. This changes the frequency of the carrier wave, and 

determines the timbre or tone colour). The third parameter is the ‘modulation index’. This is the 

amount by which the second sine wave changes the frequency of the first. 

 

Making an FM patch 
 

To make an FM patch, first we create a cycle~ for the carrier, with a gain~ to control the level, and 

and a dac~ for output. This is the basic frequency of our note. But we are going to modulate this 

frequency, which means we add or take away a small amount from the frequency. NOTE: we are 

not adding or taking away from the signal output by the cycle~, rather we are adding or taking away 

from the frequency of the cycle~ not its amplitude.  

 

To do this we create a second cycle~. This is the modulator. This will be summed with the 

frequency of the first, so the freq of the first will vibrate up and down. But we need to control how 

much of the modulator is added, because this makes a big difference. This is the ‘modulation index’ 

(basically the input volume of the modulator). To do this we need a *~ object at the output of the 

modulator cycle~, and a floanum to control it. 

 

When we change the carrier frequency, the ‘note’ changes, but do we not want the timbre to 

change. We want the ratio between the carrier and modulator to remain constant. We do this by 

multiplying the carrier by a ‘harmonicity ratio’. If we use (say) a harmonicity ration of 2, we 

guarantee that the modulator is always double the frequency of the carrier, no matter what note the 

carrier is playing. 
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In order to change the values continuously without clicks or glitches, we need to use signals rather 

than numbers. So we can put sig~ after all the numbers, to turn the numbers into signals. 

 

We may also need one more modification. To get an even timbre, we need more modulation at high 

frequencies, and less at low. To do this we times the modulation index by the modulation 

frequency. This means we can use small numbers for the mod index, rather than huge ones. It also 

means we get more modulation as we play higher notes. This is not strictly essential for FM 

synthesis but can be very useful. 
 

Envelopes and shaping 
 

Last time we used function and line~ to create envelopes. We can do the same here, to control the 

timbre. With many real instruments, the timbre changes over time. So we can use another function 

to control the modulation index. 
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Introduction to Max/MSP 

WXK1015 

Semester 2 

 

Week 8- First steps in polyphonic synthesis. 
 

FM synthesis 
 

It would be great if our FM patch could play more than one note at a time. It would also be good if 

it could play loud and quiet, and if the timbre changed depending on whether we play loud or quiet 

(i.e. if we could have more or less modulation index depending on how hard we play the keys). 

 

Making the subpatch 

 

First, we need to make our monophonic FM synthesiser it into a subpatch. We will need one 

subpatch for each simultaneously sounding note. The subpatch input will be a MIDI note pair 

(pitch, vel). We follow this with unpack 0 0 so that we can get the pitch and velocity separately. 

When a pitch arrives, we need to bang the envelopes to make the envelope trigger, so we use 

trigger i bang or t i b. The bang comes first, and bangs both envelopes, then, the int goes through 

and connects to mtof, so that the note number becomes a frequency. 

 

The envelope duration and harmonicity ratio will come from our main patch, so we can use send 

and  receive objects for these values. And instead of a DAC for output, we will use a patch output 

(the DAC will be in the main patch). Also we don’t need a gain fader (that will be in the main 

patch). 

 

As before, we will have two envelopes using function objects, one for the amplitude envelope and 

one for the modulation index. The note duration (received from the main patch) will feed a 

setdomain message to the amplitude envelope function. But we don’t want to have to draw these 

envelopes for each instance of our subpatch. Say we had 32-note polyphony, with 32 subpatches – 

it would take a long time to draw 64 envelopes in all those objects! It would be much better if we 

could have amplitude and mod-index functions in the main patch, and feed these through to all our 

subpatches. We need two receive objects, receive amp-env to receive amplitude envelope data and 

feed it to the subpatch amplitude function, and receive index-env for the modulation index data 

going to the modulation index function. Would it be possible to just feed the values through 

without the function objects? 

 

Velocity 

 

The final element in the subpatch is velocity control. We want greater amplitude and more 

modulation index when we play louder. The way to do this is divide the velocity by 127. (so that it 

becomes a value between 0 and 1, note the decimal place after the 127 to prevent rounding). Then 

we multiply this value by the output of the line~ obects which are driven by the functions. 
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Making the main patch 

 

The main patch is relatively easy. We just need as many instances of our subpatch as we want to 

play simultaneous notes (or ‘voices’). Let’s say 4 in this case (but it could be 32, or 128, but 

probably less than 10 as you only have a maximum of 10 fingers!) Our input will be notein – from 

an external keyboard or MIDI sequencer. We can also have a kslider object connected to makenote 

to use for on-screen playing (mainly for testing). Both of these will give us a pitch, velocity list. 

 

The main difficulty of triggering polyphonically is keeping track of which notes are on and which 

are off. New notes might begin before old ones have finished. How do we remember which notes 

are on, so we can be sure to turn them off when they are supposed to finish? Luckily there is an 

object that can do this for us – poly. Arguments are the number of voices we want (that is 

simultaneous notes), and a voice stealing flag. We can just use 1 as the flag for now, so we put poly 

4 1. (IMPORTANT: this is poly without a ~) 

 

The inputs to poly are our pitch and velocity. The outputs are voice number, pitch and velocity. 

We need to turn this into a list, by using pack 0 0 0. We can now use an object called route. This 

looks at a list and matches the first element with its arguments. If there is a match the rest of the list 

comes out of that output. Since the first element in each list is going to be the voice number, we can 

give route arguments of 1 2 3 4. Route will then look at the voice number of each note, and send 

the rest of the list (the pitch and velocity) out of the appropriate output. Therefore the final 

argument of route and the first argument of poly should be the same in this case. We then can send 

each output to a different instance of our subpatch (it will be unpacked inside the subpatch). 

All the outputs of our subpatches can just go to a gain fader, and then a DAC. 
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Setting the amplitude and mod-index envelopes 

 

We send one global harmonicity ratio to all the subpatches., We also want to draw our amplitude 

and mod-index envelopes in the main patch, and get this copied to all the functions in the 

subpatches. We do this by using the message dump sent to our main functions. This causes all the 

data to come out of the dump outlet of the function (the third outlet), and we can send this to send 

amp-env (and the other one to send index-env). 

 

In order to get the dump to happen, we actually need to send two messages. First, we need to send 

the message clear to clear all the data from the subpatch function. We can send this through the 

send. Next, we need to send the message dump to the main patch function. Finally, we need to 

connect the dump outlet to the send object as well. 

 

What we want is for any change in the main function to cause an identical change in the subpatch 

function. So we use the bang outlet of the main function (this just bangs whenever we change the 

main function). We use this bang with a trigger object, using the arguments dump and clear. 

When we edit the main function, a bang is created, and this triggers FIRST the clear message, 

THEN the dump message. 

 

 

Class exercise:  

Build a polyphonic synth using FM 

techniques. It does not need to be exactly like 

this one, but it needs to work! 

This needs to be working for next week even if 

you have not finished it in class as we will 

then build on from it.  
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Introduction to Max/MSP 

WXK1015 

Semester 2 

 

Week 9 – A better way to create polyphony: poly~ 
 

 
 

The power of poly~ 
 

Last time we looked at using poly (without a ~) to distribute notes to separate subpatches, each of 

which created one ‘voice’ of sound. This is fine if we want a few notes at a time, but if we want lots 

(say, 16 or 32), it will quickly become unwieldy. 

 

To solve this, we have the poly~ object. This is similar to poly, in that it takes care of playing many 

notes at a time. But unlike poly, poly~ actually contains the sound making subpatch within it. 

 

Making the subpatch 

 

To use poly~ we need a subpatch – poly~ won’t do anything on its own. We can use our 

monophonic FM patch from last time, with a few modifications. 

 

The first difference is that instead of and inlet and outlet, we need the objects in and out~. (in does 

not have a ~, because it will receive note information. out~ DOES have a ~ because it will output 

the signal. Both in and out have versions for data and signals, with or without ~.) Our in and out~ 

objects need to be numbered. We use in 1 and out~ 1. 

 

The second modification is that we can make the patch stereo. We do this by adding (say) 1 to the 

frequency of the final note, and using this as the left hand channel. Because we now have two signal 

outlets, we need out~ 1 AND out~ 2.  
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Voices and instances 

 

poly~ works by creating instances of our subpatch (an instance is a ‘copy’ of the subpatch that 

exists within poly~). The first argument to poly~ is the name of our subpatch, and the second 

argument is the number of voices we want. To make extra voices, we simply increase this number. 

 

thispoly~ 

 

One of the big advanteges of poly~ is that each instance is only active when playing a note. This 

helps to save CPU power. To tell each instance of our subpatch whether or not it is playing, we use 

the thispoly~ object, and connect the output signal of the subpatch to it. If the signal is present, 

poly~ knows that this voice is busy playing a sound. But if the signal is zero, poly~ knows that this 

voice is silent, and therefore is available to play any new notes that come along. 
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The  main patch 

 

poly~ takes care of voice stealing – that is, it keeps track of which instances of our subpatch are 

currently sounding, and which are available to play new notes. poly~ will do this if we precede our 

note information with the word ‘note’, which tells poly~ it is a note event. We do this by passing 

the note list through a prepend object (so, prepend note puts the word ‘note’ in front of the note 

list). 

 

As long as we do this, we need only one poly~ object to play as many notes as we like. N.B. poly~ 

has one inlet and two outlets. This is because we have in 1, out~ 1 and out~ 2 in our subpatch. 

Different numbers of inlets and outlets in the subpatch mean different numbers in the poly~ object. 

 
 

  
 

 

 

 

 



Introduction to Max/MSP WXK1015.    Contact - ed.wright@bangor.ac.uk                             Page 60  

 
 

 

Introduction to Max/MSP 

WXK1015 

Semester 2 

 

Week 10 – Breaking out; physical I/O and Arduino.  
 

Introduction 

 

Eventually you will find that you want to controll events in the real world from Max. Max/MSP is 

very useful in that it responds to standard computer input systems such as the keyboard, mouse and 

midi very well and can output via the display, print window or audio. However this can feel rather 

limited when it comes to performance or interaction. 

 

There are a number of interfaces/contorllers available many of which are quite expensive and 

infelxible. The Arduino series of boards provide a cheap (£22) way of creating interfaces to mediate 

between the real world and Max. 

 

      
 

http://www.arduino.cc/ 

Arduino is an open-source electronics prototyping platform based on flexible, easy-to-use hardware 

and software. It's intended for artists, designers, hobbyists, and anyone interested in creating 

interactive objects or environments. The board can sense the environment by receiving input from a 

variety of sensors and can affect its surroundings by controlling lights, motors, and other actuators. 

The microcontroller on the board is programmed using the Arduino programming language  

(similar to C++). Arduino projects can be stand-alone or they can communicate with software 

running on a computer.The boards can be built by hand or purchased preassembled; the software 

can be downloaded for free. The hardware reference designs (CAD files) are available under an 

open-source license. 

The Arduino (Uno in this case) is a microcontroller board based on the ATmega328. It has 14 

digital input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16 MHz 

crystal oscillator, a USB connection, a power jack, an ICSP header, and a reset button. This implies 

that you can program it to function autonomously from its own chip, or you can use the usb link 

into Max/MSP. 

http://www.arduino.cc/
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Getting things talking 
 
The Arduino board relies upon a routine sent to the main chip to tell it what to do, this can be coded in the 

Arduino app, complied and then sent via usb to the board. This simple piece of code will make an LED blink 

if connected to pin 13 and the ground. 

 

  
 

A bundled piece of code called standard 

firmata enables the board to communicate via 

OSC with the computer down the USB cable 

once it is uploaded to the chip. 

 

In order to interface the OSC messages to 

Max we need the OSC-route object and 

files avaiable from 

http://cnmat.berkeley.edu/patch/4029  

To make for easy maipluation in Max we can 

also add the Maxiuno set of objects http://www.maxuino.org/  These files need to be placed in 

Max’s search path. 

 

Having fun 

 

Once the board and interface has been set-up it is possible to monitor the pins in a digital or 

analogue (contiuous) manner as well as sending to them. From this point most things are possible 

depending upon how good you are with hardware electronics. A lot can be achieved in creating 

different inputs from thermostats, accelerometers dynamos etc. as well as outputs to stepper motors, 

lights fans and many many less predicatable things! 

  
 
 

Maxuino Pin monitoring window. 

http://cnmat.berkeley.edu/patch/4029
http://www.maxuino.org/
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For today’s lecture I built a very simple pressure pad from two bare ended cables, a carpet tile a 

padded envelope and a bit of board. When someone steps on the cross the circuit is closed and Max 

triggers a drum loop from an sfplay~ object. Very simple in itself but imagine an entire room 

coated in these or around the outside of a giant ball all triggering different files… 
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WXK-1015 Introduction to Max/MSP 

Coursework 5 – 7.5% 

 

 

Create an interface for controlling playback of a sound file (you don’t need to do the playback part yet, just 

the user interface); 

The interface should have two buttons: play and pause; 

The play button should trigger the message “resume 0” whenever it is pressed; 

The pause button should trigger the message “pause” when pressed once, then “resume” when pressed again, 

and so on; 

The buttons should reflect their current state (they should look pressed, or change colour when pressed); 

There should be a toggle object which is checked only when playing (i.e. not when paused); 

Buttons can be textbutton objects or panels with ubutton objects; 

The buttons should have ‘hints’ to help the user; 

The buttons should be on top of a panel which ‘contains’ them visually; 

The panel should be in the background and locked. 

The background, panel and buttons should be coloured in a way that makes it look as professional as 

possible; 

Only the play/pause buttons should be visible (i.e. not the toggle, cables etc.); 

Everything should be commented. 

 

 

 

Due: at the class in Week 4  

AND by email to ed.wright@bangor.ac.uk by the same deadline 

 

(You will also need to demonstrate your patch during the class) 
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WXK-1015 Introduction to Max/MSP 

Coursework 6 

 

 

Create a patch for playing sound files, which has the following features: 

• Stereo sound output 

• Play and pause buttons contained in a bpatcher (may have been submitted as Exercise 5) 

• Ability to drag and drop soundfiles to load them 

• Playback volume control and meters 

• Readout of current playback position in hh:mm:ss 

• Play and pause also controllable via the qwerty keyboard 

• Compact and well designed user interface, with hints. 

• Fully commented throughout (including dependencies – e.g. the bpatcher). 

(Remember to submit the bpatcher and any other subpatches along with the main patch). The easiest way to 

do this is to pack everything in a .zip file. (Put everything in a folder, then alt-click and choose ‘compress’.) 

 

 

 

Due: at the class in Week 6 

AND via Blackboard by the same deadline 

 

(You will also need to demonstrate your patch during the class) 
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WXK-1015 Introduction to Max/MSP 

Coursework 7 

 

Create a monophonic synthesiser (one note at a time) capable of playing sounds synthesised using FM 

synthesis. It should have the following features. 

• Stereo sound output 

• MIDI input 

• Ability to adjust harmonicity ratio and modulation index 

• Control of loudness and modulation index via envelope functions 

• A variety of presets with some interesting sounds 

• Compact and well designed user interface, with hints. 

• Fully commented throughout (including dependencies). 

(Remember to submit any other subpatches along with the main patch). 

 

 

 

Due: at the class in Week 10 

AND by Blackboard by the same deadline 

 

(You may also need to demonstrate your patch during the class) 
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WXK-1015 Introduction to Max/MSP 

Assignment 2 

 
Create a software synthesiser-sampler with the following features: 

• able to be controlled by a MIDI keyboard or a sequencer programme 

• able to play sounds using a variety of techniques, including additive synthesis, FM 

synthesis and sample playback 

• able to mix techniques within a single sound (for example, a sampled attack with an FM 

decay) 

• able to design new sounds and save them as presets for later use 

• able to switch quickly between different kinds of sounds during performance 

• Attack, Decay, Sustain, Release control (ADSR). 

• velocity control of notes 

• sustain pedal control (hold pedal to sustain notes) 

• volume control of overall output levels using fader or knob 

• split keyboard capability (one sound in one part, and another in the other) 

• controllable reverb effect (using the yafr2~ reverb object) 

• well designed, good looking, informative and easy to use interface (including hints) 

• well organised and documented ‘under the bonnet’ (including comments) 

NOTE: this may be an updated version of your Semester 1 assignment, but MUST 

show evidence of development and improvement. It can also be redesigned from scratch 

if you wish. 

 

Marks will also be awarded for additional useful and innovative features. However, these 

must be within the overall design brief described above (for example, the ability to 

spatialised sounds in stereo would be a useful addition to the design brief, but the ability to 

play movies would not). 

 

Due: Noon, Monday of Week 13 

Submit via Blackboard 

 

 

 


